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Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes.
Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and
filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically
explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified service
personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small
children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by
the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.
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Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or
any consumable products other than those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.
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Welcome

The PowerLite” 1700¢/1710¢ is an easy-to-use projector that weighs
less than 4 pounds. The projector offers up to 2700 lumens (1710c) or
2200 lumens (1700c¢) of brightness. You can connect it to a wide
range of computers and video sources.

Easy setup, control, and security:

B 5-second startup time and Instant Off” feature for fast setup and
shut down

B Automatic digital keystone correction
m  1.2x optical zoom lens for flexible placement and positioning

B Security features include password, user’s logo, and the ability to
lock the projector buttons

B  A/V mute slide to block the lens and save lamp life when you
want to temporarily stop projecting
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Using Your Documentation

This book contains all the information you need to set up and use

your projector. Please follow these guidelines as you read through it:

Warnings must be followed carefully to avoid bodily injury.
Cautions must be observed to avoid damage to your equipment.
Notes contain important information about your projector.

Tips contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your

projector? Here’s where you can look for help:

Quick Setup sheet

Gives you the instructions you need to get your projector up and
running if you are connecting to a notebook, MacBook,™
PowerBook; or iBook” computer.

Projector kit

Includes this User’s Guide, your Quick Setup sheet, warranty
brochures, and Epson PrivateLine” Support card. Keep the kit
with your projector at all times.

Built-in help system

Provides assistance for common problems. Available from the
Help button on the projector or the remote control. See page 68
for details.

epson.com/support
Download FAQs and e-mail your questions to Epson support.

If you still need help after checking this User’s Guide and the
sources listed above, you can use the Epson PrivateLine Support
service to get help fast. Call (800) 637-7661 and enter the PIN on
the PrivateLine card. Or take advantage of Epson’s automated
support services 24 hours a day. See page 78 for more
information.


http://www.epson.com/support

B presentersonline.com
Includes a library of articles covering presentation tips, tricks, and
technology. The site provides templates, clip art and sound clips,
as well as Presenters Services to use on the road. Even more
resources and services are available if you register to join the
Presenters Club—and it’s free.

Registration and Warranty

Your projector comes with a basic carry-in 2-year and 90-day lamp
warranty as well as an international warranty that let you project with
confidence anywhere in the world. For details, see page 94 and the
warranty brochure included with your projector.

In addition, for customers who register their projector, Epson offers
free Extra Care™ Road Service. In the unlikely event of an equipment
failure, you won’t have to wait for your unit to be repaired. Instead,
Epson will ship you a replacement unit anywhere in the United States
or Canada, usually via overnight delivery. See the brochure included
with your projector for details.

To register, simply fill out the registration card and mail it to Epson.
Or you can register online at http://www.epson.com/webreg.
Registering also lets you receive special updates on new accessories,
products, and service.

Welcome
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Unpacking the Projector

After unpacking the projector, make sure you have all the parts shown
below:

PDF manual and

registration CD-ROM %
== ~\

Remote control and
2 AAA batteries

Power cable VGA computer cable Carrying case

Save all packaging in case you need to ship the projector. Always use
the original packaging (or the equivalent) when you need to send the
projector to another location. If you are moving the projector by
hand, use the carrying case. See page 11 for ordering information, and
page 66 for transportation instructions.

Additional Components

Depending on how you plan to use the projector, you may need
additional components:

B To receive an S-Video signal, you'll need an S-Video cable. One
may be provided with your video equipment, or you can purchase
one from Epson; see below.

B To receive a component video signal from a VCR or other video
device, you'll need an HD15 to component video cable. You can
purchase one from Epson; see below.



Optional Accessories

To enhance your use of the projector, Epson provides the following
optional accessories:

Product Part number
Replacement lamp V13H010L38
Air filter replacement set (2 filters) V13H13408
Universal ceiling mount ELPMBUNI
False ceiling plate ELPMBFCP
Security bracket/cabling for gyro lock mounts ELPMBSEC
Adjustable ceiling channel ELPMBACC
Suspension adapter ELPMBAPL
Kensington® security lock ELPSLO1
50-inch portable screen (4:3 aspect ratio) ELPSCO6
60-inch portable pop-up screen (4:3 aspect ratio) ELPSCO7
80-inch portable pop-up screen (4:3 aspect ratio) ELPSCO08
83.6-inch hanging pull-down screen (4:3 aspect ELPSC09
ratio)

Component video cable ELPKC19
S-Video cable ELPSVO1
Distribution amplifier ELPDAO1
Image presentation camera (ELPDCQ5) V12H162020

You can purchase screens, carrying cases, or other accessories from an
Epson authorized reseller. To find the nearest reseller, call
800-GO-EPSON (800-463-7766). Or you can purchase online at

www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).

Welcome
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Displaying and Adjusting
the Image

W hether you're presenting from a computer or video equipment,

you need to follow some basic steps to display your image on the

screen.

Follow the guidelines in this chapter for:

Positioning the projector

Turning the projector on and selecting the image source
Troubleshooting display problems

Adjusting the image

Turning off the projector

13



note

You can mount the projector
on the ceiling, or place it
behind a translucent screen
for rear projection. See

page 81 for details.

Positioning the Projector

If the projector isn’t already installed in the room you’re using, you’ll
probably want to place it on a table in front of the screen, as shown.
This lets you stand in the front of the room, face the audience, and
remain close enough to the equipment to be able to control it. Try to
leave as much space as possible between the projector and the screen to
get a good-size image.

Use the figure below to help you determine placement. Image size
increases with distance, but can vary depending on how you position
the zoom ring and whether you’ve adjusted the image with other
settings.

33.1t039.7 ft 6.6t0 7.9 ft 3.2t03.9ft Distance from screen

Also keep these considerations in mind:
m  Place the projector on a sturdy, level surface.

m  Make sure there is plenty of space for ventilation around and
under the projector. Do not set the projector on top of anything
that could block the vents under the projector.

m  Make sure the projector is within 10 feet of a grounded electrical
outlet or extension cord.

14 Displaying and Adjusting the Image



Ideally, you should place the projector directly in front of the center of

.. note
the screen, facing it toward the screen squarely. The base of the lens y e
Ifter positioning the
should be at about the level of the bottom of the screen. projector, you may want to

connect a Kensington

this from Epson; see
page 11.

Projector
Screen

= ————f————f————~————~———~————~———~-----------------:-----I

If you place the projector below screen level, you’ll have to tilt it up by
extending the front adjustable foot. This causes the image to become
“keystone” shaped, but you can correct the distortion by pressing the
buttons on the projector. See page 21 for detailed information about

correcting the image shape.

For instructions on installing the projector in a permanent location,
such as a theater or conference room, see page 81.

Projecting the Image

Make sure your projector and other equipment are set up as described
on page 33. Then follow the instructions below to start the projector

and display an image.

Turning On the Projector

Turn on any connected computer or video equipment before starting
the projector so it can automatically detect and display the image
source. If you turn on the projector first, or have multiple pieces of
connected equipment, you may have to select the image source
manually (see page 17).

Displaying and Adjusting the Image

MicroSaver® anti-thefi
device ro the lock port on the
projector. You can purchase

15



note

To shut down the projector,
see page 23. Shutting down
the projector correctly
prevents premature lamp
Jailure and possible damage
[from overheating.

Follow these steps to turn on the projector:

1. Open the A/V Mute slide (lens cover).

2. Plug one end of the power cable into the projector, and the other

end into an electrical outlet.

Power light D g %QC
.
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3. Press the red O Power button on the remote control or on top of
the projector.

Menu
Source
Power  Search O
& ™

Enter/

The projector beeps once and the Power light flashes green as the
projector warms up, then an image begins to appear. When the
Power light stops flashing and remains green, the projector is
ready for use.

4. If you've connected a Windows-based computer to the projector,
you may see a New Hardware Wizard screen saying your
computer has found a plug-and-play monitor; if so, click Cancel.

5. If you are prompted to enter a password, see page 51.

Selecting the Image Source

Selecting the image source lets you switch between images input from
different pieces of connected equipment (such as a computer or DVD

player).
If you don’t see the image you want, press the Source Search button

on the projector or the Search button on the remote control until

you see the image you want to project.

You can also use the Source buttons on the remote control to switch
between devices connected to the ports identified on each button. The
PowerLite 1700c/1710c does not support EasyMP™

warning

Never look into the lens
when the lamp is on. This
can damage your eyes, and is

especially dangerous for
children.

note

To focus and adjust the
image, see page 20. If a
projected image fails ro
appear, see page 18 for help.

Displaying and Adjusting the Image 17



Troubleshooting Display Problems

Follow these guidelines if you’re having trouble displaying an image.

You Can’t Project an Image
If you don’t see the image you are trying to project, try the following:

B Make sure the cables are connected correctly, as described
beginning on page 33.

B Make sure the Power light is green and not flashing and the A/V
Mute slide is open.

m Ifyou’ve connected more than one computer and/or video source,
you may need to press the Source Search button on the
projector’s control panel or Search button on the remote control
to select the correct source. (Allow a few seconds for the projector
to sync up after pressing the button.)

m If you're using a PC notebook, press the function key on your
keyboard that lets you display on an external monitor. It may be
labeled CRT/LCD or have an icon such as £/). You may have to
hold down the Fn key while pressing it. Allow a few seconds for
the projector to sync up after changing the setting.

The Projector and Notebook Don’t Display the
Same Image

If you’re projecting from a notebook, and you can’t see your image on
the projection screen and on your computer at the same time, follow
these guidelines.

If you're using a PC notebook:

B On most systems, there’s a function key that lets you toggle
between the LCD screen and the projector, or display on both at
the same time. It may be labeled CRT/LCD or have an icon such as
Z2/0). You may have to hold down the Fn key while pressing it.
Allow a few seconds for the projector to sync up after changing
the setting.

18 Displaying and Adjusting the Image



m  If the function key doesn’t permit you to display simultaneously
on both screens, you should check your monitor settings to make
sure both the LCD screen and the external monitor port are

enabled.

From the Control Panel, open the Display utility. In the Display
Properties dialog box, click the Settings tab, then click
Advanced. The method for adjusting the settings varies by
brand; you may need to click a Monitor tab, then make sure the
external Monitor port is set as your primary display and/or
enabled. See your computer’s documentation or online help for
details.

If you’re using Mac OS X:

You may need to set up your system to display on the projector screen
as well as the LCD screen. Follow these steps:

1. From the Apple® menu, select System Preferences, then select
Displays.

2. Make sure the VGA Display or Color LCD dialog box is selected.

3. Click the Arrangement (or Arrange) tab.

asn Color LCD =]
« ma® @
Show All Désplays  Sound Network  Startup Disk

! Display Arrangement« Color

Ta rearrange the displays, drag them ta the desired pasition.
To rebocate the menu bar, drag it to a different display.

Make sure

Mirror Displays —f——# Mirror Displays
is checked

4. Make sure the Mirror Displays checkbox is selected.

Displaying and Adjusting the Image
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Adjusting the Image
Once you see your image, you need to make certain adjustments:

m  If the image is too high or too low, you can reposition it. See
below.

m To focus or zoom your image, see page 21.
m  If the image isn’t square, see page 21.
m Ifa computer image displays incorrectly, see page 23.

m  Ifyou need to fine-tune the image and/or sound, see Chapter 4.

Adjusting the Height of Your Image

If the image is too low on the screen, you can use the front adjustable
foot to raise it.

1. Stand behind the projector. Press the blue foot release lever up
and lift the front of the projector.

00000000000
00000000000
00000000000
00000000090
00000000000

2. Once the image is positioned where you want it, release the lever

\ @ to lock the foot in position.
T

e> <§ 3. If necessary, you can fine-tune the height or level the image by

turning the projector’s adjustable rear foot.

Proj rrear f .. . . .
olectorreartoot  Raising the projector causes the image to distort or “keystone,” but

you can correct the shape as described on page 21.

20 Displaying and Adjusting the Image



Focusing and Zooming Your Image
Turn the focus ring on the projector to sharpen the image.

Turn the zoom ring on the projector to reduce or enlarge the image.

2

Focus Zoom

If the image still isn’t large enough, you may need to move the
projector farther away from the screen. You can also use the E-Zoom
buttons on the remote control to zoom in on a portion of the image.
See page 29 for instructions.

Adjusting the Image Shape

In most cases, you can maintain a square or rectangular image by
placing the projector directly in front of the center of the screen with
the base of the lens level with the bottom of the screen.

Even if the projector is slightly tilted (within a range of 30° up or
down), the projector has an automatic keystone correction function
that detects and corrects vertical keystone distortion.

Projector tilted up Corrected image Projector tilted down

It takes about one second after projection starts for the image to be

corrected. During this time, a vertical keystone correction gauge

appears on the screen. / \ —_

If your image is still distorted, you can correct it using the Keystone A
) . . , . Keystone correction
buttons on the projector’s control panel or the projector’s Setting

menu.

Displaying and Adjusting the Image 21



note

The image will be slightly
smaller after adjusting. If
it’s important to maintain
the correct aspect ratio, use
the menu system to perform
keystone correction, then use
the remote’s Resize button
10 adjust the aspect ratio. See
page 30.

Using Keystone Correction

To adjust your image when it is wider on the top or bottom, do the

following;

Press one of the two triangular buttons on the projector’s control
panel, as shown below. Continue pressing the button until you
are satisfied with the shape of the image.

/= L

Menu AN Esc

O Cb O heip

@/0» (o 2
Enter

\J

Or press the Menu button on the remote control or projector,
select the Setting menu, and press Enter.

A/VMute Freeze

EBRTT Menu 7Y Esc

e Source

Search ?E @ D
U

From the Setting menu, select Keystone and press Enter. Use
the ) pointer button on the remote control to adjust the

EBNER|Er

Search

Volume

keystone setting as needed.

If the image becomes uneven, decrease the sharpness setting. (See

page 47.)
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Correcting Computer Images

If you’re connected to a computer and the image doesn’t look right,
press the Auto button on the remote control or the Enter button on
the projector. This automatically resets the projector’s tracking, sync,
resolution, and position settings.

If the Auto button doesn’t correct the problem, you may need to
adjust the tracking or sync using the projector’s Signal menu. See
page 49 for more information.

Using the A/V Mute Slide

You can use the A/V Mute slide to temporarily turn off the image and

sound when you want to redirect your audience’s attention.

Shutting Down the Projector

When you’ve finished using the projector, follow the recommended
procedure to shut it down. This extends the life of the lamp and
protects the projector from possible overheating.

1. Turn off any equipment plugged into the projector.

2. To turn off the projector, press the red O Power button on the

remote control or projector.

Menu
Source
Power  Search O
& M

Enter—”

note

You must be projecting an
image for this button to have
any effect. The Auto button
works only with computer
images projected through the
VGA port.

note

Lamp life results will vary
depending on mode selected,
environmental conditions,
and usage.

Turn off this product when
not in use to prolong the life
of the projector.

Displaying and Adjusting the Image 23



note

You can set the projector ro
automatically turn off the
projector lamp and enter
“sleep mode” when it has
not received any signals for
30 minutes. This conserves
electricity, cools the
projector, and extends the
life of the lamp. If you want
to start projecting again,
press the O Power button.
If you are done using the
projector, unplug the power
cord. To enable sleep mode,
see page 57.

note

If a power outage occurs
when Direct Power On is
enabled and the projector is
plugged in, the projector will
start when the power is
restored.

5.

You see a confirmation message. (If

you don’t want to turn it off, press 537 U
Yes: ) button
any Other button') Ho: Pr y other button

Press the © Power button again. The
lamp turns off. When the projector beeps twice, you can unplug
the power cord.

(If the projector is mounted on the ceiling, you will need to wait
20 seconds for the projector to cool down before you can unplug
the power cord.)

If you want to turn the projector on again, make sure the orange
light is not flashing, then press the O Power button.

If you extended the adjustable front foot, press up on the blue
foot release lever to retract it.

Close the A/V Mute slide.

Using the Direct Power On Function

The Direct Power On function enables faster setup. The projector will

start up automatically when you plug it in; you won’t have to press the
O Power button.

Follow these steps to enable Direct Power On:

1.

2.

4.
5.

Press the Menu button on the remote control and select the
Extended menu.

Choose Operation and press Enter.

Choose Direct Power On and press Enter.

[Direct Power OH] Return

Lo
MOFF

| [Esc]:Return [®]:Select [Enter]:Set Henu) zExit |

Highlight On and press Enter.

Press Esc or Menu to exit. The setting will take effect the next
time you plug in the projector.
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note

For information and
resources to help you give
the most professional
presentation, be sure to visit
presentersonline.com.

Using the Remote Control

The projector includes a number of tools to enhance your

presentation. All of them can be accessed using the remote control,

which lets you operate the projector from anywhere in the room—up

to 20 feet away.

You can use the remote control to adjust the picture and sound

(page 27) or as a pointer to highlight your presentation (page 32). You

can also use it to adjust the color mode for various environments

(page 30) or as a wireless mouse when projecting from a computer

(page 31).

This chapter covers:

Using the remote control
Controlling the picture and sound
Operating your computer with the remote control

Highlighting your presentation

25
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Using the Remote Control

note
If a button is pressed longer

Follow these tips for using the remote control:
than 30 seconds, the remote

control stops operating to m  Point the remote control at the front of the projector or at the
conserve power. When you screen.

release the button, normal

operation resumes. m  Stand within 20 feet of the projector.

B Avoid using the remote under bright fluorescent lamps or in
direct sunlight, or the projector may not respond properly.

Replacing the Batteries

caution Replace the batteries as described below:
When replacing batteries,

take the following 1. Turn the remote control over.
precautions: 2. Press down on the tab on the

w Replace the batteries as battery cover as you lift the cover
soon as they run out. If the off.

batteries leak, wipe away

battery fluid with a soft
cloth. If fluid gets on your

hands, wash immediately.

m Do not expose bareries to 3. Install two AAA batteries <
heat or flame.

inserting the + and — ends as

m Dispose of used batteries "“\ <
pose of shown. i

according to local
regulations.

m Remove the batteries if
you won't be using the

projector for a long period of

time. ..
4. Position the cover as shown, then
press down until it snaps into / Y
lace. /
P \\JQ/
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Controlling the Picture and Sound

You can use the remote control to preview and select your picture
sources, temporarily turn off the picture and sound, freeze the action,
zoom in on the picture, and adjust the volume.

Switching Between Picture Sources

If your projector is connected to more than one computer and/or
video source, you can switch between the different sources:

B The easiest way to select your source is to press the Search button
on the remote control (or the Source Search button on the
projector) repeatedly until you see the image you want on the
screen.

Pointer| A/VMute Freeze
Y ) @
Power  $9UF O

:(])@4

°

Enter—”

=

o]

Ee3
Lamp Temp

B On the remote control, there are four Source buttons. Use them
to switch between equipment connected to the port identified on
each button

After you select a source, the screen goes dark for a moment before the
image appears.

Using the Remote Control
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note

This function pauses the
image, but nor the sound.
Also, because the source
continues to transmit
signals, you won’t resume
the action from the point
you stopped it.

Turning Off the Picture and Sound

You can use the A/V Mute button on the remote control to turn off
the image and sound. This does the same thing as the A/V Mute slide
and is useful if you want to temporarily redirect your audience’s
attention.

B To turn off the picture and sound, press the A/V Mute button.
The screen turns black.

B To turn the image and sound back on, press the button again.

A/VMule Freeze
(] (5) (=

You can have the screen turn blue when you press the A/V Mute
button. You can also have an image, such as a company logo, display

on the screen (see page 54).

Stopping Action

You can use the remote control to stop the action in your video or

computer image.

B To stop the action and keep the current image on the screen, press
the Freeze button. The sound continues.

m  To restart it, press the Freeze button again.

A/VMule Freeze
) )

Computer

Search
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Zooming Part of Your Image

You can zoom in on a portion of the image using the E-Zoom buttons
on the remote control.

1. Press the E-Zoom @) button on the remote control.
You see a crosshair indicating the center of the zoom-in area.

2. Use the ) pointer button to position the crosshair.

3. Continue pressing the E-Zoom @) button to enlarge the selected
area up to 4 times.

4. While the image is enlarged, you can:
m  Use the () pointer button to move around the screen.
B Press the E-Zoom @ button to zoom out.

5. When done, press the ESC button to return the image to its
original size.

Controlling the Volume

To change the volume, press the &) or ) button on the remote

note

control or projector.
pro) To temporarily shut off the

sound and picture, press the
AN Mute button or close
the A/ Mute slide.

You can also adjust the volume using the projector’s menu system. See
) g ) Yy

page 50.
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Computer Menu

ERNER| RN

S-Video  Video | Resize Help

m A/VMute  Freeze
(o) (own]
omputer  Eas) Tode

Resizing Video Images

You can use the Resize button on the remote control to adjust how
an image fits into the display area.

For video images, press Resize to switch the aspect ratio between 4:3
and 16:9, (and Normal for computer images). This lets you play
certain digital video images or movies recorded on certain DVDs in
16:9 widescreen format.

For computer images, resizing is normally unnecessary, since the
projector automatically resizes the image to make the best use of the
display area. If you press the Resize button on the projector or remote
control, the projector displays the image at the output resolution of
the computer (which makes the image larger or smaller, depending on
its resolution). If the resolution of the image is the same as the
projector’s (1024 x 768), pressing Resize has no effect.

Adjusting the Color Mode

You can use the Color Mode button on the remote control to adjust
the color, brightness, and other aspects of your image.

Press the button repeatedly to select from the following settings:
Photo: For vivid, high-contrast still images in a bright room.

Sports (video, S-video, or composite video only): For vivid TV
images projected in a bright room.

Presentation: For computer presentations (the default when
projecting from a computer with analog video).

Theatre: For optimizing movie images with increased contrast.

Game: For increased brightness when playing video games or
watching TV in a bright room. Emphasizes dark gradations.

sRGB: For matching the color palette of standard sSRGB computer
displays

Blackboard: For projecting accurate colors on a green chalkboard
(adjusts the white point).

Customized: For manual color adjustment. (See page 46).
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Operating Your Computer with the
Remote Control

If you connect a computer to the projector with a USB cable, as
described on page 35, then select Link21L for the USB Type B setting
in the Extended menu (see page 58), you can use the remote control
in place of your computer’s mouse. This gives you more flexibility
when delivering slideshow-style presentations, since you won’t have to
stand next to the computer to change slides.

B Use the [*J Up and [}J Down buttons to move through a
slideshow.

Page up or down
to change slides
in PowerPoint

Left-click

Right-click

B Use the &) pointer button to move the cursor on the screen.

B Press the Enter button once to left-click, or press it twice to
double-click. Press the Esc button to right-click.

m  To drag-and-drop, hold down the Enter button. Then use the
) pointer button to drag the object. When it’s where you want i,
press Enter to release it.

Using the Remote Control
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Highlighting Your Presentation

You can display a pointer to call out important information on the
screen. If you want to customize the pointer tool, you can choose from
three alternative shapes.

Using the Pointer Tool

1. To activate the pointer tool, press the Pointer button on the
remote control. A pointer appears on the screen.

A/V Mute Freeze

alo <
er  EasyM| Mode Menu
| CsJ) (O ""l Pointer
Vids

ideo Resize Help K4

.
.

»

P
Search

) )
Volume ‘E

If you prefer to use a different style of pointer, see the instructions
in the next section.

2. Use the ) pointer button on the remote control to position the
pointer on the screen.

3. When you're done using the pointer, press Esc to clear the screen.

Customizing the Pointer Tool

You can change the appearance of the pointer by choosing from three
alternative shapes.

1. Press the Menu button on the remote control, highlight the
Settings menu, highlight Pointer Shape, and press Enter. You
1” O =\ can select one of the pointer shapes shown at the left.

2. Select the shape you want and press Enter.
3. Highlight Return and press Enter.

4. Press Menu to exit from the menu system.
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Connecting to Computers

and Other Equipment

This chapter tells you how to connect the projector to a notebook or
desktop computer, and/or to video equipment, such as a VCR, DVD
player, or video camera.

Follow the instructions in this chapter on:
m  Connecting to a computer
m  Connecting video equipment

m  Playing sound through the projector
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Connecting to a Computer

You can connect the projector to any computer that has a standard
video output (monitor) port, including desktop models, PC notebook
and notebook computers, MacBooks, PowerBooks and iBooks, and

note

If you connect a Windows-
based computer to the
projector, you may see a
New Hardware Wizard
saying your computer has hand-held devices.

Jfound a plug-and-play

monitor; if so, click Cancel. B To connect to the blue Computer/Component Video port

(standard VGA cable connection), see the instructions below.

Connecting to the Computer Port
You can connect to the blue Computer/Component Video port

using the VGA computer cable that came with the projector (the
monitor port on your computer must be a mini D-sub 15-pin port).

1. Ifyou’re using the VGA computer cable, connect one end to the
projector’s blue Computer/Component Video port, and the
other end to your computer’s monitor port. Then go to step 3.

caution

Don’t try to force a
connector to fit a port with a
different shape or number of
pins. You may damage the
port or connector.

2. You can connect an optional stereo mini-jack audio cable to play
sound through the projector (see page 40), or connect a USB
cable to use the remote control as a mouse (see page 35).
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3. When you've finished making any connections, see page 15 for
instructions on turning on the projector and adjusting the image.

Connecting the Cable for Remote Mouse
Control

If you've connected a computer as described in this chapter (using the
Computer/Component Video port) and set the USB Type B setting note

under the projector’s Extended menu to Link21L (see page 58), you The remote mouse control
can use the projector’s remote control as a wireless mouse. This lets function may not operate
you control your computer and click through slideshow-style correctly on systems that

have been upgraded from an

presentations, such as PowerPoint, from up to 20 feet away. ‘ / /
earlier version of Windows.

The wireless mouse function is supported on systems with a USB port
running Windows XP, 98SE, Me, or 2000, or Mac OS X 10.2.x to
10.4.x. This function is not supported if you use an S-Video cable to
connect your computer to the projector.

1. Locate the USB cable that came with your projector.

2. Connect the square end of the cable to the projector’s
< USB port. note

For details on how to use the
remote control in place of
your computer’s mouse, see

page 31.

3. Connect the flat end of the cable to any available USB port on
your notebook or desktop computer.

4. If necessary, configure your computer to work with an external
USB mouse. See your computer documentation for details.
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RCA connector
(composite video)

il ) ©

S-Video
connector

VGA connector
(RGB video)

Connecting to Video Equipment

You can connect several video sources to the projector at the same

time. Before starting, look at your video equipment to determine its

available video output connections:

If your video player has a yellow RCA-style video output
connector, see “Connecting a Composite Video Source” on

page 37.

If your video player has an S-Video connector, see “Connecting
an S-Video Source” on page 38.

If your video player has a component video port (three connectors
labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a

Component Video Source” on page 39.

If your video player has an RGB video port (either a single
connector for a VGA-style monitor cable or three connectors

labeled R/G/B), see “Connecting an RGB Video Source” on
page 40.

After connecting video cables, you may also want to connect an audio

cable to play sound through the projector; see page 40.
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Connecting a Composite Video Source

1.

Locate an RCA-style video cable (one is usually provided with
your video equipment or you can purchase one from an
electronics dealer).

Connect the cable to the yellow video output connector on your

player and the yellow Video connector on the projector:

If you want to play sound through the projector, see page 40 for
instructions on connecting audio cables.

If you don’t need to make any other connections, see page 15 or
the Quick Setup sheet for instructions on turning on the projector
and adjusting the image. Once the projector is turned on, select
the image source: press the Search button on the remote control
or press the Source Search button on the projector’s control
panel repeatedly until the image appears.

Connecting to Computers and Other Equipment
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Connecting an S-Video Source

1. Locate an S-Video cable (one is usually provided with your video
equipment or you can purchase one from Epson; see page 10).

2. Connect the cable to the S-Video connector on your player and

the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 40 for
instructions on connecting audio cables.

4. Ifyou don’t need to make any other connections, see page 15 or
the Quick Setup sheet for instructions on turning on the projector
and adjusting the image. Once the projector is turned on, select
the image source: press the Search button on the remote control
or press the Source Search button on the projector’s control
panel repeatedly until the image appears.
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Connecting a Component Video Source

You will need a component-to-VGA video cable or a component

video-to-VGA adapter for this connection. You can order the
component-to-VGA cable (ELPKC19) from Epson; see page 11 for
more information.

1.
2.

Locate a component-to-VGA video cable or adapter.

Connect the cable to your player and the blue
Computer/Component Video connector on the projector.

Component-to-
VGA adapter

Component-to-VGA cable
(ELPKC19)

If you want to play sound through the projector, see page 40 for

instructions on connecting audio cables.

If you don’t need to make any other connections, see page 15 for
instructions on turning on the projector and adjusting the image.
Once the projector is turned on, select the image source: press the

Search button on the remote control or press the Source

Search button on the projector’s control panel repeatedly until

the image appears.

note

Be sure your video player is
not an RGB video source.
If you select the wrong
source, image quality may
sufffer. Check your video

player’s documentation.

Also, make sure the
Computer Input setting in
the Signal menu is set ro
Auto or Component Video
(see page 49).
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note

Be sure your video player is
not a component video
source. If you select the
wrong source, image quﬂ/ity
may suffer. Check your
video player’s

documentation.

Connecting an RGB Video Source
1. Locate the VGA computer cable provided with the projector.

2. Connect the cable to the video port on your player and the
Computer/Component port on the projector.

{/
il

3. If you want to play sound through the projector, see page 40 for
instructions on connecting audio cables.

4. Ifyou don’t need to make any other connections, see page 15 for
instructions on turning on the projector and adjusting the image.
Once the projector is turned on, select the image source: press the
Search button on the remote control or press the Source
Search button on the projector’s control panel repeatedly until
the image appears.

Playing Sound Through the Projector

You can play sound through the projector’s speaker system.
To play sound through the projector, follow these steps:

1. Locate the appropriate cable and connect it to the Audio jack on
the projector.
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m If you have a computer connected to the blue Computer/
Component Video port, use a stereo mini-jack cable.

m  If you have video equipment connected to the Video or
S-Video port, use an RCA-style audio cable and the audio
adapter included with the projector.

Audio

adapter S 5
‘& %

2. Connect the other end of the cable to the audio output

connector(s) on your computer or video equipment.

Connecting to Computers and Other Equipment
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Fine-Tuning the Projector

You can use the projector’s on-screen menus to adjust the image,

sound, and other features. This chapter covers the following

information:

m  Using the menu system

B Adjusting the image

m  Adjusting signal settings

m  Customizing projector features

m  Using the projector security features
m  Customizing power and operation
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note

The Network option does
not appear in the
1700c/1710c menu.

Using the Menu System

You can use the remote control or the projector’s control panel to
access the menus and change settings. Follow these steps:

1. To display the menu screen, press the Menu button on the
remote control or on the projector.

A/VMute Freeze
(o] (wm) Menu 7%  Esc
K gearch

ource CAD O
ﬂ» 2
J s

You see a menu screen similar to the one below:

Video Resize

Search

Volume

Options
|

Image Return
b Color Hode Presentation
Signal Brightness 0

Contrast 0
Settings Sharpness
. fbs. Color Temp.
Menu list Extended Color Adjustment

Reset

Hetwork
Info

Reset

[ [#1:Select [Enter]:Enter [Henu] :Fxit |

The menus are listed on the left and the options available for the
highlighted menu are shown on the right.

2. Use the ) pointer button on the remote control (or the
navigational buttons on the projector) to scroll through the menu
list. When you’ve highlighted the desired menu, press the Enter
button to select it.

3. Once you've selected the menu, use the () pointer button to
scroll through the list of options. (Some of the options may be
grayed out or unavailable, depending on the selected source.)
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4. After highlighting the option you want to adjust, use the
) pointer button to change the setting. In some cases, you may
have to press the Enter button to view a sub-screen for changing
the setting.

B Press the left or right side of the () pointer button to adjust  FoE——wo
a slider bar.

m  To select fr?m Fwo or more. settmg§, use the O pointer
button to highlight the desired setting and press Enter. ILow

5. After changing the settings, press the Esc button to save your
changes and return to the previous menu (or press it repeatedly to
exit the menu system).

You can also press the Menu button to exit.

Restoring the Default Settings

You can use the menu system’s Reset options to restore the factory-
default settings for all the settings listed in a specific menu, or all the
settings in all menus.

To restore the settings in a specific menu, enter the menu whose
settings you want to change, select Reset, and confirm as needed.
(The example below shows how to reset the Image menu.)

Image Return
= Color Hode Presentation
0

Signal Brightness
Contrast 0
Settings Sharpness
. Abs. Color Tenp.
Reset settings Extended Color Adjustment
for current menu Reset

Hetwork note
oy When you select Reset All

Reset settings for

in the Reset menu, it does
all menus

Reset

not reset the Computer
Input, Video Signal, User’s
Logo, Language, or Lamp
To restore all the projector settings to their factory-default values, settings.

select the Reset menu, highlight Reset All, and press Enter.

[ [#1:Select [Enter]:Enter [Menu] :Exit |
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Adjusting the Image

You can use the Image menu to adjust the brightness, sharpness, color,

tint, and contrast.

1.

Press the Menu button on the projector or remote control and
select the Image menu. You see the Image menu screen.

Image Return
" Color Hode Presentation
$ignal Brightness

Contrast
Settings Sharpness

Abs. Color Temp.
Extended Color Adjustment

Reset

Hetwork
Info

Reset

([ [#]:Select [Enter]:Enter [Henu]:Exit |

2. Use the ) pointer button to highlight the desired option, then
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adjust it as needed:

m Color Mode

Lets you quickly adjust the color and brightness for various
environments. Use either the remote control or the Color
Mode setting in the Image menu. You can save a different
setting for each source. Select from these settings:

Photo: For vivid, high-contrast still images in a bright room.

Sports (video, S-video, or composite video only): For
vivid TV images projected in a bright room.

Presentation: For computer presentations (the default when
projecting from a computer with analog video).

Theatre: For optimizing movie images with increased
contrast.

Game: For increased brightness when playing video games or
watching TV in a bright room. Emphasizes dark gradations.

sRGB: For matching the color palette of standard sSRGB
computer displays.



Blackboard: For projecting accurate colors on a green

chalkboard (adjusts the white point). note
] ) The Brightness setting
Customized: For manual color adjustment. (See below.) changes the opacity of the

projector’s LCD panels. You
can also change the lamp’s
brightness. Select

m Contrast Brightness Control in the
Setting menu, then choose
High or Low (the default
m Color Saturation (video only) setting is High).

Adjusts the color depth of the image.

m Brightness
Lightens or darkens the overall image.

Adjusts the difference between light and dark areas.

m Tint (video only)
Adjusts the balance of green to magenta in the image
(available only for component video or NTSC signals).

m Sharpness
Adjusts the sharpness of the image.

m Color Adjustment
Adjusts the color values. For Customized color mode, select
RGBCMY to adjust individual red, green, blue, cyan,
magenta, and yellow hue and saturation values. For other
color modes, RGB may be selected to adjust red, green, and
blue hue and saturation values. (Not available if SRGB is
selected as the Color Mode setting.)

m  ABS Color Temp.
Sets a color temperature between 5000 and 10000 °K. (Not
available if SRGB is selected as the Color Mode setting.)

Six-Axis Color Adjustment

For special projection material, such as high-quality photographs or
artwork, you can adjust the hue and saturation for six different color

axes.

1. Follow the instructions on page 46 to open the Image menu and
select Color Mode.

2. Press the Enter button to select Customized, then press Esc to
return to the Image menu.
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3. Select Color Adjustment and press Enter. You see hue and
saturation controls on the screen for six colors: RGBCMY (red,
green, blue, cyan, magenta, and yellow.

4. Select the color axis you want to adjust and press Enter. You see
color controls for hue and saturation.

Hue changes the balance of color, and saturation changes the
strength of the color.

5. Use the ) pointer button to adjust the hue and saturation. You
see the adjustments reflected on the screen. When you are satisfied
with the color, press Esc.

6. Repeat steps 4 and 5 for each color axis you want to adjust.

You may need to readjust the color as the lamp in your projector
changes over time.

Adjusting Signal Settings

Although the projector normally detects and optimizes the input
note
You can also use the remote
control’s Auto button to
automatically reset the

signal automatically, you can use the Signal menu to make manual
adjustments. In addition to changing the position of the projected
image, you can correct tracking and sync for computer images, or

projector’s tracking, sync, change the aspect ratio to widescreen format for video images.
resolution, and position .
; , 1. Press the Menu button and select the Signal menu.
settings. See page 23 for
details. You see a screen similar to one of those below. (The settings will

be different depending on the source you are projecting from.)

Return Return Return
Auto Setup
Tracking

ve
eo $ignal

Computer/RGB Video Component Video Composite Video/S-Video
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Use the (7) pointer button to highlight the desired option, then
adjust it as needed:

Auto Setup

Leave this setting On to automatically optimize the computer
image. Turn it off if you want to save adjustments you have
made to the video settings.

Tracking
Adjust this value to eliminate vertical stripes in the image.

Sync
Adjust this value if the image appears blurry or flickers.

Progressive

Turn this setting On to convert composite video signals into
progressive signals (best for still images). Leave the setting Off
for moving images.

Position

If the image is slightly cut off on one or more sides, it may not
be centered exactly. Select this setting and use the () pointer
button to center it.

Computer Input

If the colors don’t look right on the Auto setting, select the
setting for the type of equipment you’ve connected to the
Computer/Component Video port:

RGB: For a computer connection.

Component Video: For a video player that outputs a
component video signal.

Video Signal
Leave this setting at Auto unless you are using a 60-Hz PAL
system (then select PAL60).

Resize
Choose an aspect ratio of either 4:3 or 16:9. Normal is the
default setting for a computer connection.

tip

Before adjusting tracking or
sync, fill the screen with an
image containing fine
detail. For example, in
Windows you can select a
pattern to appear as your
desktop background. If this
option isn’t available, try
projecting black text on a
white background.
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Customizing Projector Features

You can use the Settings menu to lock the buttons on the projector,

adjust audio volume, and customize several other features.

note -
You can also adjust the

volume using the remote

control.
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Return

Image
Keystone 0

futo Keystone On
Operation Lock off
Pointer Shape Pointer 1
Brightness Control High
VoTume 10

Reset

Signal

Settings (]
Extended
Info

Reset

[ [#]1:Select [Enter]:Enter [Henu]:Fxit )

Keystone

Squares up the shape of the image after the projector has been
tilted upward. If you notice lines or edges looking jagged after
adjusting the shape, decrease the Sharpness setting (see page 46).

Auto Keystone

Automatically compensates for keystone distortion when the
projector is tilted upward. This feature is available only when the
projector is set for front projection (it is enabled by default).

Operation Lock
Lets you disable all of the buttons on the projector except the
O Power button. See page 56 for more information.

Pointer Shape
Lets you choose from three alternative pointer shapes. See page 32
for more information.

Brightness Control

Lets you select from two levels of brightness. The Low setting
reduces power consumption and noise, and extends the lamp’s
operating life.

Volume
Raises or lowers the volume of the projector’s speaker.



Using the Projector Security Features

To prevent unauthorized use of the projector, you can do the
following:

B Assign a password; this can be disabled for a set period if you want
to loan the projector to someone.

m  Create an identifying user logo that is displayed at startup and/or
when the A/V Mute button is pressed. See page 54.

m  Disable the projector’s buttons; this is useful, for example, if
you're projecting in a classroom and you want to ensure that no
one touches the projector’s buttons while you’re using the remote
control. See page 56.

If you create a user’s logo for the projector, you can set up the logo so
it is displayed as the startup screen and/or AV/Mute screen.
Unauthorized users cannot turn it off or change it. This feature is
intended to discourage theft and provides a way to identify the
projector should it be stolen.

Enabling Password Protection

To prevent unauthorized use, you can assign the projector a password.
If you do, a screen will appear requesting the password whenever the
projector is plugged in and turned on. If an incorrect password is
entered three times in succession, the projector’s operation is locked
and the power cord must be disconnected and reinserted to redisplay
the password screen. If an incorrect password is entered thirty times in
succession, the user must contact Epson to unlock the projector.

The default setting for the Password Protect function is Off. Follow
these steps to turn password protection on:

1. DPress the Freeze button on the remote control for about five
seconds.

note
It’s a good idea to write
down your password.

If you leave the projector
plugged in, the Password
Protect Release screen will
not appear. You only need a
password if you unplug and
reconnect the power cable.
Nerwork Protect is not
available for the
1700c/1710c projector.
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caution
If you lose the remote

control, you will not be able 2.
to enter the password. Keep
the remote control in a safe 3
place at all times. ’
4.
5.
m A/VMute  Freeze 6'
7.
8.
9.
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You see this screen:

[Password Protect]

Password Timer off
Timer OH
Tine-elapsed OH

User’s Logo Protect Off

Hetwork Protect off

Password

([ [#1:Select [Enter]:Enter [Henu] :Exit

Use the () pointer button to set Power On Protect to On. Then
press Enter.

Press Esc.
Select Password and press Enter.

When you see a message asking if you want to change the
password, select Yes and press Enter.

Hold down the Num button on the remote control and use the
numeric keypad to enter a four digit password. (The default
setting is 0000.)

When you see a confirmation message, reenter the password.
Then press the Menu button to exit the screen.

Press the Num button on the remote control to deactivate the
numeric keypad.

If you want to disable the password temporarily, select Timer and
press Enter. Then hold down the Num button while you use the
numeric keypad to enter the number of hours (from 0 to 9999)
that you want the password feature disabled. If you want the
projector to request the password every time it is turned on, set
the timer to OH.

The countdown for the elapsed time begins as soon as you close
the Password Protect menu. (You can check the elapsed time in
this menu next to Time elapsed.)



10. To enable your screen logo, select User’s Logo Protect and press
Enter. Select On and press Enter.

When this feature is on, the logo appears whenever you turn on
the projector (if the Startup Screen is enabled in the Extended
menu; see page 54). It also appears when you press the A/V Mute
button (if you selected the Logo for the A/V Mute setting under
Display in the Extended menu). None of the User’s Logo features
in the Extended menu can be changed when the User’s Logo
Protect function is enabled.

Starting the Projector with a Password

When the password function is enabled, you see this screen when you
plug in and turn on the projector:

[Password]

Enter the password.

#Refer to the "User’s Guide" for the operation.

m AV Mute  Freeze
©J

Computer _ EasyMP) g

ERNEN|

S-Video  Video

O™ @)

Volume

Hold down the Num button on the remote control and use the

Resize | Hel

S

numeric keypad to enter the four digit password.

The password screen closes, the numeric keypad is automatically
deactivated, and projection begins.

If the password is not correct, you see a message prompting you to
re-enter the password. If you enter an incorrect password three times
in succession, you see the message The projector’s operation will be
locked. Request code xxxxx and the projector switches to standby
mode for approximately 5 minutes. Write down the request code.
Then disconnect the projector’s power cord from the electrical outlet,
reconnect it, and turn the projector back on.

When you see the Password Protect Release screen again, you can try
to enter the correct password.
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If you enter an incorrect password 30 times in succession, the
Yy
projector remains locked and you must contact Epson to unlock it.

If you have forgotten the password, contact Epson with the request
code number that appears in the Password Protect Release screen for
assistance. See “Where To Get Help” on page 78.

Creating Your Own Startup Screen

You can transfer any image from your computer or video source to the
projector and then use it as your startup screen. You can also use it as
the screen displayed when the projector is not receiving a signal or
when you press the A/V Mute button. The image can be a company
logo, slogan, photograph, or any other image you want to use.

Capturing the Image

Start by displaying the image you want to use from either a computer
or video source, such as a DVD player. Then follow these steps to
capture the image and transfer it to the projector:

1. Press the Menu button on the remote control, highlight the
Extended menu, and press Enter.

2. Highlight User’s Logo and press Enter.

Inage Return
Display
Signal
Projection Front
Settings Operation
& Standby Mode Hetwork Off
Extended USB Type B EasyMP
| Link 211 0ff
Hetwork Multi-screen
Language English
Info Reset
Reset
[ [Escl:Return [#]:Select [Enter]:Enter [Henu]:Exit )

3. When you see a message asking Choose this image as the
user’s logo?, select Yes and press Enter. A selection box displays
over the image.
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Use the (7)) pointer button to select the area of the image you
want to use. Then press Enter.

When you see the message Select this Image?, highlight Yes
and press Enter.

Use the arrow buttons to select a zoom rate (display size) and press
Enter.

When the message Save this image as the user’s logo?
appears, select Yes and press Enter. Saving the logo may take a
few moments. Do not use your projector, remote control, or
video source while the logo is being saved.

When you see the message Completed, press Esc to return to the

menu screen.
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Choosing When to Display the Image

After your image is saved, it is automatically set as the startup screen.

You can also set it to display as the screen you see when there’s no

signal or when you press the A/V Mute button (see page 28).

1.

Press the Menu button, highlight the Extended menu, and press
Enter.

Select Display and press Enter.

Highlight Display Background (for when there is no signal) or
A/V Mute, and press Enter.

Select Logo and press Enter.

When you’re finished, press Esc to exit.

Disabling the Projector’s Buttons

note When you enable the Operation Lock function, you can lock all the
Press the Enter button on projector’s buttons, or all buttons except the Power button.
the projector’s control panel T .
for 7 seconds 1o disable the 1. Press the Menu button, highlight the Settings menu, and press
Operation Lock function. Enter.

2. Select Operation Lock and press the Enter button.

3. Select Full Lock (to lock all projector buttons) or Partial Lock (to

lock all buttons except the Power button) and press Enter.
4. Select Yes and press Enter to confirm the setting.
5. DPress the Menu button to exit.
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Customizing Power and Operation

You can use the Extended menu to customize the way the projector
displays images, enable quick startup, turn sleep mode on or off, and
customize other projector operations.

Image Return
Display
Signal User’s Logo
Projection
Settings Operation
. Link 211 Off
Extended (4} Multi-screen
e language English
Info Reset
Reset
[[#1:Select [Enter]:Enter [Henu] :Exit
m Display

Use this setting to turn off the display of messages, change the
background color, enable logo display, or turn off the startup
screen display.

m User's Logo

Create a custom startup screen, as described on page 54.
note

m Projection If Direct Power On is
enabled, the power cable is

Select Front (to project from the front of a screen and right side
connected, and a power

up), Front/Ceiling (when the projector is mounted upside-down

.1 . . outage occurs, thé’ rojector
from the ceiling), Rear (to project from behind onto a & 1oy

will start when the power is

transparent screen), or Rear/Ceiling (to project from behind onto vestored.

a transparent screen when the projector is mounted upside-down

from the ceiling). Do not use the projector at
- o altitudes above 7500 ft

When you select one of the Ceiling projection methods, the (2,286 m).

projector requires a 10-second cool-down after you turn it off.
You need to wait until you hear the projector beep before
unplugging it.

m Operation
Enable Direct Power On if you want to have the projector start
when the power cable is connected (without pressing the Power
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button). Enable Sleep Mode if you want to have the projector
turn off automatically if it is idle (and no signal is received) for 30
minutes or when the A/V Mute Slide is Closed. Enable High
Altitude Mode when you are using the projector above 4900 ft
(1500 m).

Link 21L

This setting is available only if you select Link21L for the USB
Type B setting. Select Off if you want to use the remote as a
wireless mouse for a USB-connected computer. See page 35 for
more information.

Language
Select from nine languages to be used for the projector menus.



warning

Before you clean any part of
the projector, turn it off and
unplug the power cord.
Never open any cover on the
projector, except the lamp
cover. Dangerous electrical
voltages in the projector can
injure you severely. Do not
try to service this product
yourself, except as specifically
explained in this User’s
Guide. Refer all other
servicing to qualified service
personnel.

Maintaining the Projector

Your projector needs little maintenance. All you have to do is keep

the lens clean. You may also need to clean the air filter and vent. A

clogged air filter or vent can block ventilation needed to cool the

projector.

The only parts you should replace are the lamp and air filter. If any

other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

Cleaning the lens

Cleaning the projector case
Cleaning the air filter and vent
Replacing the lamp and air filter

Transporting the projector
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caution

Do not use wax, alcohol,
benzene, paint thinner, or
other chemical detergents.

These can damage the case.

Cleaning the Lens
Clean the lens whenever you notice dirt or dust on the surface.
Use a canister of compressed air to remove dust.

To remove dirt or smears on the lens, use lens-cleaning tissue. If
necessary, moisten a soft cloth with lens cleaner and gently wipe the

lens.

Cleaning the Projector Case
Before you clean the case, turn off the projector and unplug the power
cord.

B To remove dirt or dust, wipe the case with a soft, dry, lint-free

cloth.

B To remove stubborn dirt or stains, moisten a soft cloth with water
and a neutral detergent. Then wipe the case.
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Cleaning the Air Filter and Vent

Your projector includes an air filter to ensure the best performance. If
dust collects on the air filter (on the bottom of the projector) or vent
(on the front of the projector), clean them as described below. Dust
clogs prevent proper ventilation and can cause overheating and

damage the projector. note
To order replacement air
Follow these steps: filters, request part number

VI3H13408. See page 11
Jfor ordering information.

1. Turn off the projector. Wait for the Power light to stop flashing,
then unplug the power cord.

2. To clean the intake vent and filter, use a small vacuum cleaner
designed for computers and other office equipment. If you don’t
have one, gently clean the vent with a soft brush (such as an
artist’s paintbrush).

You can remove the air filter to clean both sides.
® - . /4

Vent

3. If the dirt is difficult to remove or the filter is broken, replace the
filter as described on page 64. Contact your dealer or call Epson at
800-GO-EPSON (800-463-7766) to obtain a new filter.
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Replacing the Lamp and Air Filter

note

When you get a replacement The life span of the projection lamp is about 2000 hours if

lamp for your projector, you Brightness Control in the Setting menu is set to High (default), and
should replace the filter. 3000 hours if Brightness Control is set to Low.

To check how long the lamp It is time to replace the lamp when:

has been in use, see page 71. -

Turn off this product when -
not in use to prolong the life

The projected image gets darker or starts to deteriorate.

The message Replace the lamp appears on the screen when the
lamp comes on and the lamp warning light -O- flashes orange. To
maintain projector brightness and image quality, replace the lamp
as soon as possible.

The lamp warning light -O- flashes red (the lamp is burnt out).

Contact your dealer or call Epson at 800-GO-EPSON
(800-463-7766). Request part number V13H010L38.

Follow these steps to replace the lamp and air filter:

of the projector.
|
. 1.
warning
Let the lamp cool fully 2.
before replacing it.

In the unlikely event that
the lamp has broken, small
glass fragments may be
present and should be

removed carefully to avoid
injury.

If the lamp is used after the 3.
replacement period has

passed, the possibility that

the lamp may break

increases. When a lamp
replacement message

appears, replace the lamp

with a new one as soon as

possible, even if it is still

working.
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Turn off the projector.

When the Power light stops flashing, unplug the power cord.

Let the projector cool for at least an hour (if it has been on). The
lamp is extremely hot immediately after use.



4. Loosen the lamp cover screw (you don’t need to remove it). Then
slide the lamp cover to the side and lift it off of the projector.

5. Loosen the two screws holding the lamp in place (you can’t

remove them).

Loosen, but don't
remove these screws

note

The lamp(s) in this
product contain mercury.
Please consult your state and
local regulations regarding
disposal or recycling. Do not
put in the trash.

7. Gently insert the new lamp. (If it doesn’t fit easily, make sure it is
facing the right way.)
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10.
11.

12.

Push down the corner marked PUSH until it snaps in.
Once the lamp is fully inserted, tighten its screws.
Replace the lamp cover, then tighten its screw.

Slide out the air filter on the bottom of the projector and
remove it.

Slide in the new air filter until it clicks in place.

13. Reset the lamp timer as described in the next section.
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Resetting the Lamp Timer
After you replace the lamp, you need to reset the lamp timer using the
projector’s menus.

1. Press the Menu button on the remote control or on the
projector’s control panel. You see the main menu.

2. Use the ) pointer button on the remote control (or the arrow
buttons on the projector) to highlight Reset, then press Enter.

You see this screen:

Image Return
Reset A1l

Signal Reset Lamp Hours

Settings

Extended

Hetwork

Info

[Reset

[ [#1:Select [Enter]:Enter [Menu]:Exit |

3. Select Reset Lamp Hours and press Enter.
4. When you see the prompt, select Yes and press Enter.

5. When you’re finished, press Esc or Menu to exit the Menu

system.
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Transporting the Projector

The projector contains many glass and precision parts. Follow these
guidelines to prevent damage:

B When shipping the projector for repairs, use the original
packaging material if possible. If you do not have the original
packaging, use equivalent materials, placing plenty of cushioning
around the projector.

note m  When transporting the projector a long distance, first place it in a
Epson shall not be liable for hard-shell shipping case, then pack it in a firm box with
any damages incurred

. . cushioning around the case. (An optional case is available from
during transportation.
Epson; see page 11.)

B Close the A/V Mute slide (lens cover) to protect the lens.
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Solving Problems

This chapter helps you solve problems with your projector, and tells
you how to contact technical support for problems you can’t solve
yourself. The following information is included:

m  Using the projector’s on-screen help system

B What to do when the projector’s status lights flash
m  Solving projector operation problems

m  Solving problems with the image or sound

m  Solving problems with the remote control

m  Contacting technical support
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Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can
get help by pressing the blue ? Help button on top of the projector or
on the remote control. The following choices are available:

m  “No Signal.” or no image appears on the screen

m Thereis no sound
m Select a different language
Follow these steps to get help:

1. Press the blue ? Help button on the remote control or on the
projector.

Computer  EasyMP)  froge  Menu

() I O

S-video  Video Resize Help

You see the Help Menu.

2. Usethe © pointer button on the remote control or the
navigational buttons on the projector to highlight menu items.

3. DPress the Enter button on the remote control or on the projector
to select the menu item.

4. To exit the help system, press the ? Help button.

If none of the suggestions solve your problem, see additional solutions
to problems in the following sections.



Checking Projector Status

If your projector isn’t working correctly, first turn it off, wait for it to
cool (the Power light stops flashing orange), and unplug it. Then
plug the power cord back in and turn on the projector. If this doesn’t
solve the problem, check the lights on top of the projector.

What To Do When the Lights Flash

The lights on top of the projector indicate the projector’s status.
Power light

Temperature
light

Lamp light

Refer to the following table for a complete description of the
projector’s status lights:

Status lights
Light Status Description
| Orange The projector is in sleep or standby mode. You can unplug it or press the
O | :
O Power button to turn it on.
(b Flashing green The projector is warming up. Wait for the image to appear.
d Green The projector is operating normally.
d Flashing orange | The projector is cooling down. You can’t turn it back on (and you should

not unplug it) until the light stops flashing and remains orange.

d Red There is a problem with the projector. Check the other two lights and the
information on page 70 to diagnose the problem.

Solving Problems 69



Status lights (continued)

Light

Status

Description

i

Flashing red

There is a problem with the fan or temperature sensor. The air filter or
vent may be clogged. Clean them or replace the air filter as described on
page 61.

If this does not resolve the problem, stop using the projector, disconnect
the power cable, and contact Epson as described on page 78.

Flashing orange

Rapid cooling is in progress. Although this is not an abnormal condition,
projection will stop automatically if the temperature rises higher. Make
sure there is plenty of space around and under the projector for
ventilation, and that the air filter and vents are clear.

Red

The projector is overheating, which turns the lamp off automatically.
Wiait until the cooling fan stops, then unplug the power cord. Plug the
power cord back in and press the O Power button. Make sure the room
temperature is not above 95 °F (35 °C), and there is plenty of space
around and under the projector for ventilation.

The air filter or vent may be clogged. Clean them or replace the air filter
as described on page 61.

If the projector continues to overheat after you clean the air filter, the
problem may be caused by damage to the cooling fan or temperature
sensor. Contact Epson for help as described on page 78.

Warning: Except as specifically explained in this User’s Guide, do not
attempt to service this product yourself.

Flashing orange

It's time to replace the lamp. See page 62 for instructions. If you continue
to use the lamp after the replacement warning, there is an increased
possibility that the lamp may break.

Flashing red

The lamp may be burnt out. First make sure the lamp cover is securely
installed. If that’s not the problem, let the lamp cool, remove the lamp,
and replace it as described on page 62.

The air filter or vent may be clogged. Clean them or replace the air filter
as described on page 61.

If this does not resolve the problem, contact Epson as described on
page 78.

Flashing red

Power is cut off because of an internal problem. Unplug the power cord
and contact Epson for help, as described on page 78.
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Viewing Lamp Usage and Other Information

Use the Info menu to view information about the display settings of
your computer and the number of hours the lamp has been used.

Press the Menu button and highlight the Info menu.

You see the lamp usage hours and various input signal settings on the

right. note

The life span of the lamp is about 2000 hours if the Brightness The i”ﬁ’”’””‘"’f’ diSP[‘fﬂ’fd

Control setting in the Setting menu is set to High (default), and depends on the input signal
currently selected.

3000 hours if the Brightness Control setting is set to Low. Make
sure you have a spare lamp handy if the usage hours on this menu
are close to the life span of your lamp.

Solving Projector Operation Problems

The power doesn’t turn on.

m  If the projector doesn’t turn on when you press the O Power
button, make sure the power cable is connected to the projector
and plugged into a working electrical outlet.

B The power cable may be defective. Disconnect the cable from the
outlet and contact Epson as described on page 78.

B Check to see if the A/V Mute Slide is closed.

The buttons on the projector don’t work.

If the Operation Lock function has been enabled, you can’t use the
buttons on the projector. Try using the remote control instead. See
page 56 for information about the Operation Lock function.
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Solving Problems with the Image

or Sound

No image appears on the screen.

Check that the Power light is green, not flashing.

The projector may be in standby or sleep mode. If the Power
light is orange, press the O Power button to turn the projector
on.

If the power was switched off and then on again, the projector
may be cooling down. Wait until the Power light stops flashing
and remains orange; then press the O Power button again.

Press the A/V Mute button on the remote control to make sure
the picture has not been turned off temporarily.

Open the A/V Mute Slide, if it is closed.

The attached computer may be in sleep mode or displaying a
black screen saver. Try pressing a key on the computer.

If you are projecting from a DVD player or other video source,
make sure you turn it on and press its Play button.

You’ve connected a computer and see a blue screen with the
message No Signal displayed.

Make sure the cables are connected correctly, as described on

page 34.
Try restarting your computer.

If you’ve connected a computer and one or more video sources,
you may need to press the Source Search button on the
projector or one of the source buttons on the remote control to
select the correct source. Allow a few seconds for the projector to
sync up after pressing the button.



If you’re using a PC notebook:

Hold down the Fn key on the keyboard and press the function
key that lets you display on an external monitor. It may have an
icon such as /), or it may be labelled CRT/LCD. Allow a few
seconds for the projector to sync up after pressing it. Check your
notebook’s manual or online help for details.

On most systems, the /) key lets you toggle between the LCD

screen and the projector, or display on both at the same time.

Depending on your computer’s video card, you might need to use
the Display utility in the Control Panel to make sure that both the
LCD screen and external monitor port are enabled. See your
computer’s documentation or online help for details.

If you’re using Mac OS X:

1.

2
3
4.
5
6

Open System Preferences.

Click Displays.

Click Detect Displays.

Make sure the VGA Display or Color LCD dialog box is selected.
Click the Arrangement or Arrange tab.

Make sure the Mirror Displays checkbox is selected.

The message Not Supported is displayed.

Make sure the correct input signal is selected in the Signal menu
(see page 48).

Make sure your computer’s resolution doesn’t exceed UXGA
(1600 x 1200) and the frequency or refresh rate is supported by
the projector (see page 85). If necessary, change your computer’s
resolution setting as described below.

Only part of the computer image is displayed.

Press the Auto button on the remote control.

Make sure the image Position setting is correct in the Signal
menu. See page 49 for more information.

Solving Problems
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Press the Resize button on the remote control.

Press the Esc button on the remote control to cancel the E-Zoom
function.

Make sure your computer’s resolution setting is correct. Ideally, it
should be 1024 x 768 to match the projector’s native resolution.
If this option isn’t available, select one of the other compatible
video formats listed on page 85.

B Windows:
Right-click the desktop, select Properties, click the Settings
tab, and select a different resolution.

B MacOSX:
Open System Preferences, click Displays, and select a
different resolution.

You also may need to modify existing presentation files if you
created them for a different resolution. See your software
documentation for specific information.

The image isn’t square, but keystone-shaped.

If the top or bottom of the image is broader, press the ¥ or
button on the projector until the image is square.

If the projector is angled toward the screen from the left or right,
the image will be broader on one side. Center the projector in
front of the middle of the screen, facing the screen squarely.

Enable the Auto Keystone feature to automatically fix the shape.
See page 50.

The image contains static or noise.

If you’re using a computer cable longer than 6 feet, or an
extension cable, the image quality may be reduced.

Keep your computer and video cables away from the power cord
as much as possible to prevent interference.



B The video signal may be split between the computer and the
projector. If you notice a decline in the projected image quality
when the image is displayed simultaneously on your notebook
computer and the projector, turn off the notebook’s LCD display.

B Make sure the correct input signal is selected in the Signal menu

(see page 49).

The image is blurry.

B There may be dirt or smears on the lens. Clean the lens as
described on page 60.

m  Adjust the focus using the focus ring (see page 21).

B Make sure the lens is not fogged by condensation. You may need
to wait before using the projector after moving it from a cold
environment to a warm environment.

B Adjust the Sharpness setting on the Image menu (see page 47).
When you change video settings, you should be able to see the
effect on the screen immediately. If youre projecting from a
computer, you may also need to adjust the tracking and sync as
described in the next section. If you don’t like the new settings,
you can always select Reset to return to the factory default
settings.

You see vertical bands or the image still looks blurry after
trying the solutions in the previous section.

m Ifyou’re projecting from a computer and displaying an image that
contains a lot of fine detail, you may notice vertical bands or some
of the characters may look heavy or blurred. Press the Auto
button on the remote control to reset the projector’s tracking and
sync settings.

m  If further adjustment is needed, you can fine-tune the Tracking
and Sync settings manually using the Signal menu, as described

on page 49.

1. Fill the screen with an image containing fine detail, such as a
pattern to appear as your desktop background, or try
projecting black text on a white background.
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note

Because of the different
technologies used, your
projected image may not
exactly match the colors on
your notebook or computer
monitor.
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2. Adjust the Tracking to eliminate vertical bands.

PR R

The image is too light or dark, or colors are incorrect.

m Ifyou're displaying a computer image, use the Color Mode
option in the projector’s Image menu to adjust the color (see

page 40).

m Ifyou're displaying video, adjust the Color Adjustment and
Color Mode settings on the Image menu. You can also try
adjusting the Color Saturation, ABS Color Temp, and Tint
settings on the Image menu.

m  Try adjusting the Brightness and Contrast settings on the Image

menu.
m  Check your computer display settings to correct the color balance.

m  The projector’s lamp may need to be replaced. See page 62 for
instructions.

There is no sound, or the sound is not loud enough.

B Press the<]) button on the projector or remote control to increase

the volume.

B Make sure A/V Mute is not enabled. (The A/V Mute button may

have been pressed.)

B Make sure the A/V Mute Slide is open.



m  Try adjusting the Volume setting in the Setting menu (see
page 50).

m Ifyou’re using a VCR or other video source, make sure the
volume is not turned all the way down or muted. Also, make sure
the cables are connected correctly, as described on page 40.

m  Ifyour presentation includes computer audio, make sure the
volume control on your computer is not turned all the way down
or muted. If you're using the audio cable, make sure it is securely
connected to both the projector and your computer’s

() headphone jack or i) audio out jack.

B Make sure the Windows volume controls on your computer are
not turned all the way down or set to Mute. You may be able to
check this by clicking the volume control in your Windows
system tray (lower right corner of the screen).

B Make sure the Mac volume controls are not turned all the way
down. You may be able to adjust the volume from your menu bar
(top right corner of the screen) or via the volume control function
keys.

Solving Problems with the Remote
Control

The projector doesn’t respond to remote control commands.

B The remote control’s batteries may not be installed correctly or
may be low on power. To change the batteries, see page 26.

B Make sure you are within about 20 feet (6 meters) of the projector
and within range of the projector’s front or back sensor
(approximately 30° to the left or right and 15° above or below).

B Dim the room lights and turn off any fluorescent lights. Make
sure the projector is not in direct sunlight. Strong lighting,
especially fluorescent lights, may affect the projector’s infrared
receivers. Also, turn off any nearby equipment that emits infrared
energy, such as a radiant room heater.

Solving Problems
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m Ifany buttons are held for longer than 30 seconds, the remote
enters sleep mode. Release any button that is held to wake the
remote.

Where To Get Help

Epson provides these technical support services:

Internet Support

Visit Epson’s support website at www.epson.com/support and select

your product for solutions to common problems. You can download

utilities and documentation, get FAQs and troubleshooting advice, or
e-mail Epson with your questions.

Visit http://www.presentersonline.com to access tips, templates, and
training for developing successful presentations.

Speak to a Support Representative

To use the Epson PrivateLine Support service, call (800) 637-7661
and enter the PIN on the included Epson PrivateLine Support card.
This is the fastest way of speaking to a live representative, and it’s free.
This service is available 6 AM to 6 PM, Pacific Time, Monday through
Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one
of these numbers:

m  U.S.: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday
through Friday.

B Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday
through Friday.

Days and hours of support are subject to change without notice. Toll
or long distance charges may apply.



Before you call for support, please have the following information

ready:

Product name (PowerLite 1700c/1710c)

Product serial number (located on the projector)

Proof of purchase (such as a store receipt) and date of purchase
Computer or video configuration

Description of the problem

Purchase Supplies and Accessories

You can purchase screens, carrying cases, or other accessories from an

Epson authorized reseller. To find the nearest reseller, call
800-GO-EPSON (800-463-7766). Or you can purchase online at

www.epsonstore.com (U.S. sales) or www.epson.ca (Canadian sales).
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Projector Installation

This appendix provides guidelines on installing the projector in a
permanent location, such as a theater or conference room.

The projector can be installed for four different viewing setups: front
projection, ceiling projection, rear projection onto a semi-transparent
screen, or rear/ceiling projection, as shown:

27

Front projection

Ceiling projection Rear/ceiling projection

To project from overhead, you’ll need the optional ceiling mounting
hardware; see page 11 for ordering information. You’ll also need to
select Front/Ceiling or Rear/Ceiling as the Projection option in the

. ; . . . .
projector’s Extended menu to flip the image upside-down. To project
from the rear, onto a semi-transparent screen, select Rear or

Rear/Ceiling (see page 57).
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If you’re mounting the projector on the ceiling and you place it above
screen level, you'll have to tilt the projector down to position the
image on the screen. This causes the image to lose its square shape.
You can correct the distortion using the Keystone function in the
projector’s menu system (see page 50).

If you place the projector so that the base of the lens is level with the
bottom of the screen, the image should be square and you won’t have
to adjust it. If you place the lens lower than the bottom of the screen,
you'll have to tilt the projector upward if you want to fill the whole
screen with the image.



Technical Specifications

General
Type of display

Resolution
(native format)

Color reproduction
Brightness
1700c¢

1710c

Contrast ratio

Image size

Projection distance
Projection methods
Internal sound system
Optical aspect ratio
Zoom ratio

Noise level
Keystone correction

Mouse compatibility

Epson poly-silicon TFT active matrix

1024 x 768 pixels (XGA)

16.8 million colors

2200 lumens (High Brightness mode)
1700 lumens (Low Brightness mode)

2700 lumens (High Brightness mode)
2100 lumens (Low Brightness mode)

400:1

30 to 300 inches

3.2 t0 39.7 feet (1.0 to 12.1 meters)
Front, rear, upside-down (ceiling mount)
1 W monaural

4:3 (horizontal:vertical)

1:1.2

35 dB in Low Brightness mode, 40 dB in
High Brightness mode

Automatic (manual adjustment capability
+30° vertical keystone correction)

Supports USB (type B)
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Projection Lamp

Type
Power consumption

Lamp life

Part number

Remote Control

Range

Batteries (2)

Dimensions
Height

Width

Depth

Weight

Electrical
Rated frequency
Power supply

Power consumption

UHE (Ultra High Efficiency)
170 W
Approx. 2000 hours (High Brightness

mode)

Approx. 3000 hours (Low Brightness mode)
V13HO010L38

20 feet (6 meters)
Alkaline AAA

2.7 inches (68 mm), feet retracted
10.7 inches (273 mm)

7.6 inches (193 mm)

3.51b (1.6 kg)

50/60 Hz AC

100 to 120 VAC, 2.7 A
200 to 240 VAC, 1.2 A
Operating:

100 to 120 VAC, 244 W
200 to 240 VAC, 228 W

Standby:
100 to 120 VAC, 3.8 W

200 to 240 VAC, 5.1 W



Environmental

Temperature

Humidity

(non-condensing)

Operating altitude

Safety

United States
Canada

CE Marking

pixelworks”

Operating: 41 to 95 °F

(5 to 35 °C)

Storage: 14 to 140 °F (-10 to 60 °C)

Operating: 20 to 80% RH
Storage: 10 to 90% RH
0 to 7,500 ft (0 to 2,286 m)

FCC 47CFR Part 15B Class B (DoC)
ULG60950 Third Edition

ICES-003 Class B
CSA C22.2 No. 60950

Directive 73/23/EEC
Directive 89/336/EEC

IEC 60950 Third Edition

EN 55022, EN 55024

Compatible Video Formats

The projector supports NTSC, PAL, and SECAM international video
standards, as well as the monitor display formats listed below.

Pixelworks™ DNX™ ICs are used in this projector.

To project images output from a computer, the computer’s video card

must be set at a refresh rate (vertical frequency) that’s compatible with

the projector. Some images are automatically resized to display in the

projector’s “native” format (XGA). The frequencies of some

computers may not allow images to display correctly; see your

computer’s documentation for details.

Mode

Refresh Rate (Hz)

Resolution

VGA EGA

70

640 x 350"
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Mode Refresh Rate (Hz) Resolution
VGA—60 60 640 x 480"
VESA—72 72 640 x 480"
VESA—75 75 640 x 480"
VESA—S85 85 640 x 480"
SVGA—56 56 800 x 600
SVGA—60 60 800 x 600
SVGA—72 72 800 x 600
SVGA—75 75 800 x 600
SVGA—85 85 800 x 600
XGA—60 60 1024 x 768
XGA—70 70 1024 x 768
XGA—75 75 1024 x 768
XGA—S85 85 1024 x 768
SXGA1—70 70 1152 x 864"
SXGA1—75 75 1152 x 864"
SXGA1—85 85 1152 x 864"
SXGA2—60 60 1280 x 960"
SXGA2—75 75 1280 x 960"
SXGA2—85 85 1280 x 960"
SXGA+60 60 1400 x 1050"
SXGA+75 75 1400 x 1050°
SXGA+85 85 1400 x 1050"
SXGA3—60 60 1280 x 1024"
SXGA3—75 75 1280 x 1024*
SXGA3—85 85 1280 x 1024*
UXGA—60 60 1600 x 1200"
iIMAC VGA 117 640 x 480"
iIMAC SVGA 95 800 x 600
iIMAC XGA 75 1024 x 768
MAC13 67 640 x 480"
MAC16 75 832 x 624"
MAC19 75 1024 x 768
MAC19-60 59 1024 x 768
MAC21 75 1152 x 870"
NTSC 60 —

NTSC 4:43 60 —

PAL 50 —

N-PAL 50 —

M-PAL 60 —

PAL—60 60 —

SECAM 50 —




Mode Refresh Rate (Hz) Resolution
HDTV (720p) 60 —
HDTV (720p) 50 —
HDTV (1080i) 60 —
HDTV (1080i) 50 —
TV480i 60 —
TV480i 50 —
SDTV (480p) 60 —
SDTV (480p) 50 —

“The image is resized using Epson’s SizeWise™ Technology.
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Notices

This appendix includes safety instructions and other important information
about your Epson PowerLite projector.

Important Safety Instructions

Follow these safety instructions when setting up and using the projector:

B Do not place the projector on an unstable cart, stand, or table.
B Do not use the projector near water or sources of heat.

B Use the type of power source indicated on the projector. If you are not
sure of the power available, consult your dealer or power company.

B Dlace the projector near a wall outlet where the plug can be easily
unplugged.

B Do not hold the plug with wet hands.

Take the following precautions for the plug. Failure to comply with
these precautions could result in sparks or fire: Do not insert the plug
into an outlet with dust present. Insert the plug firmly into the outlet.

B Do not overload wall outlets, extension cords, or integral convenience
receptacles. This can cause fire or electric shock.

B Do not place the projector where the cord can be walked on. This may
result in fraying or damage to the plug.

B Unplug the projector from the wall outlet before cleaning. Use a damp
cloth for cleaning. Do not use liquid or aerosol cleaners.

B Do not block the slots and openings in the projector case. They provide
ventilation and prevent the projector from overheating. Do not operate
the projector on a sofa, rug, or other soft surface, or in a closed-in
cabinet unless proper ventilation is provided.

B Never push objects of any kind through the cabinet slots. Never spill
liquid of any kind into the projector.

89



90 Notices

B Except as specifically explained in this User’s Guide, do not attempt to
service this product yourself. Refer all servicing to qualified personnel.
Opening or removing covers may expose you to dangerous voltages and
other hazards.

B Unplug the projector from the wall outlet and refer servicing to qualified
service personnel under the following conditions: When the power cord
or plug is damaged or frayed. If liquid has been spilled into the
projector, or if it has been exposed to rain or water. If it does not operate
normally when you follow the operating instructions, or if it exhibits a
distinct change in performance, indicating a need for service. If it has
been dropped or the housing has been damaged.

] The lamp(s) in this product contain mercury. Please consult your
state and local regulations regarding disposal or recycling. Do not put in
the trash.

B Unplug the projector during lightning storms or when it will not be used
for extended periods.

B Do not place the projector and/or remote control on top of
heat-producing equipment or in a hot location.

B If you use the projector in a country other than where you purchased it,
use the correct power cord for that country.

B Do not stand on the projector or place heavy objects on it.

B Do not use the projector outside of the required temperature range of 41
t0 95 °F (5 to 35 °C). Doing so may cause an unstable display and could
lead to projector damage.

B Do not store the projector outside of the required temperature range of
14 to 140 °F (-10 to 60 °C) or in direct sunlight for long periods of
time. Doing so may cause damage to the case.

WARNING: The cords included with this product contain chemicals,
including lead, known to the State of California to cause birth defects or
other reproductive harm. Wash hands after handling. (Provided in accordance
with Proposition 65 in Cal. Health & Safety Code §25249.5 et seq.)



Remote Control Information

You can operate the projector by remote control via a line-of-sight infrared
(IR) receiver at the front and rear of the projector. The projector may not
respond to remote control commands under the following conditions:

B There is an object between the remote control IR emitter and the IR
receiver on the projector.

Ambient light is too bright.
Certain types of fluorescent lighting are used.

A strong light source shines into the IR receiver.

Other equipment that emits infrared energy, such as a radiant room
heater, is in the room.

These conditions commonly cause problems for most infrared-controlled
equipment. Try the following:

B The remote control’s batteries may be low on power; replace them.
B Dim the ambient lighting and/or turn off any fluorescent lights.

B Close any window coverings and/or move the projector out of direct

sunlight.

B Turn off other equipment that emits infrared energy.

Notices
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Declaration of Conformity

According to 47CFR, Part 2 and 15, Class B Personal Computers and
Peripherals; and/or CPU Boards and Power Supplies used with Class B
Personal Computers

We: Epson America, Inc.
Located at: 3840 Kilroy Airport Way
MS: 3-13
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies
with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each
product marketed, is identical to the representative unit tested and found to
be compliant with the standards. Records maintained continue to reflect the
equipment being produced can be expected to be within the variation
accepted, due to quantity production and testing on a statistical basis as
required by 47CFR §2.909. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may
cause undesired operation.

Trade Name: Epson

Type of Product: Projector

Model: EMP-1700/1710
Marketing Name: PowerLite 1700c/1710c



FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio or television reception.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the
following measures:

B Reorient or relocate the receiving antenna.
B Increase the separation between the equipment and receiver.

B Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

B Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification of this device and may cause
interference levels which exceed the limits established by the FCC for this
equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than
one interface connector, do not leave cables connected to unused interfaces.
Changes or modifications not expressly approved by the manufacturer could
void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement
sur le materiel brouilleur du Canada.

Notices
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Warranty

Epson America, Inc. Limited Warranty
Basic Two-Year Warranty and 90-Day Lamp Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original
retail purchaser of the Epson product enclosed with this limited warranty
statement that the product, if purchased new and operated in the United
States or Canada, will be free from defects in workmanship and materials for
a period of two (2) years from the date of original purchase (except that the
warranty period is 90 days for projector lamps). For warranty service, you
must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: If your product requires service,
Epson will ask you to bring the product securely packaged in its original
container or equivalent, along with proof of the date of original purchase, to
your Epson Dealer or Epson Customer Care Center as instructed by Epson.
Epson will, at its option, repair or replace the defective unit, without charge
for parts or labor. When warranty service involves the exchange of the
product or of a part, the item replaced becomes Epson property. The
exchanged product or part may be new or previously refurbished to the
Epson standard of quality, and at Epson’s option, the replacement may be
another model of like kind and quality. Epson’s liability for replacement of
the covered product will not exceed the original retail selling price of the
covered product. Exchange or replacement products or parts assume the
remaining warranty period of the product covered by this limited warranty.
However, each replacement lamp carries the limited 90-day warranty stated
above.

What This Warranty Does Not Cover: This warranty does not apply to
refurbished or reconditioned products. This warranty covers only normal use
of the product. 24-hour-per-day or other excessive continual use causes strain
and is not considered normal use. This warranty does not cover consumables
(e.g., fuses), other than lamps. This warranty is not transferable. Epson is not
responsible for warranty service should the Epson label or logo or the rating
label or serial number be removed. Epson is not responsible for warranty
service should the product fail to be properly maintained or fail to function
properly as a result of misuse, abuse, improper installation, neglect, improper
shipping, damage caused by disasters such as fire, flood, and lightning,
improper electrical current, software problems, interaction with non-Epson
products, or service other than by an Epson Authorized Servicer. Postage,
insurance, or shipping costs incurred in presenting your Epson product for
carry-in warranty service are your responsibility. If a claimed defect cannot be
identified or reproduced in service, you will be held responsible for costs
incurred.



THE WARRANTY AND REMEDY PROVIDED ABOVE ARE
EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED
WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW
THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS
APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE.
UNLESS STATED HEREIN, ANY STATEMENTS OR
REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM
ARE VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON'S
ENTIRE LIABILITY SHALL BE LIMITED TO A REFUND OF THE
PRICE PAID FOR THE EPSON PRODUCT COVERED BY THIS
LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN
WARRANTY, NEITHER EPSON AMERICA, INC. NORITS
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE,
OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR
INABILITY TO USE THE EPSON PRODUCT, WHETHER
RESULTING FROM BREACH OF WARRANTY OR ANY OTHER
LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty
lasts and some jurisdictions do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitations and exclusions
may not apply to you.

This warranty gives you specific legal rights, and you may also have other
rights, which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:
WWW.epson.com.

To find the Epson Customer Care Center nearest you, visit
htep://support.epson.com.

You can also call the Epson Connection®™ at (800) 637-7661 + PIN or (562)
276-4394 in the U.S. and (905) 709-3839 in Canada or write to:

Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.

Notices

95



96 Notices



Index

A/V Mute, 23, 28, 56, 72
Accessories, 11
Adapter, audio, 10, 41
Air filter
cleaning, 61
ordering, 11
replacing, 62 to 64
Altitude, 58, 85
Anti-theft device, 11, 15
Aspect ratio, 83
Audio
adapter, 10, 41
controlling volume, 29
problems, troubleshooting, 76 to 77
turning off (using A/V Mute), 28
Auto button, 23
Auto Setup setting, 49

Bands, vertical, 75

Blackboard color mode, 30, 47
Blackboard, projecting on, 30
Blank screen, 18 to 19

Blurry image, 75

Brightness, 83

Brightness setting, 47

Cables
illustrations, 10
mouse, 35
ordering, 11
remote control cable set, 11
S-video, 11, 38
VGA-to-component, 34
Capturing image, 54 to 55
Carrying case, 10, 66
Ceiling mount, 11, 81 to 82

Cleaning

air filter, 61

lens, 60

projector case, 60
Color

correcting, 30

problems, 76

saturation, 47

settings, 46 to 47

temperature, 47
Color Mode setting, 46
Component video cable, 11, 36
Composite (RCA) video cable, 36 to 37
Computer

connecting to, 34 to 35

correcting images, 23

selecting source, 17
Connecting projector

to a computer, 34 to 35

to video equipment, 36 to 40
Contrast setting, 47
Customized color mode, 30, 47

Declaration of Conformity, 92
Default settings, restoring, 45
Direct Power On, 24

Distance from projector to screen, 14, 83

Documentation, 8
DVD player, connecting, 36 to 40

Electrical specifications, 84
Environmental specifications, 85
Epson
accessories, 11
presentation tips, 9
PrivateLine Support, 8
technical support, 8, 78 to 79
E-Zoom button, 29
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FCC compliance statement, 93 Lamp

Filter, see Air filter number of hours used, 71
Focusing image, 21 ordering, 11
Freeze button, 28 replacing, 62 to 65

specifications, 84

status light, 69 to 70
Game color mode, 30, 46 Lamp timer, resetting, 65
Language setting, 58, 68
Laptop computer

connecting to, 34 to 35

HDTYV images, video formats, 87 display problems, 18 to 19, 72 to 73
Height of image, adjusting, 20 selecting source, 17, 27

Help, 78 to 79 Lens, cleaning, 60

Help system, using, 68 Lights, status, 69 to 70

Help, Epson, 8 Logo, saving on projector, 54 to 56

High altitude, 58

Mac

Image display problems, 73
adjusting, 20 to 23, 46 to 47 resolution setting, 74
blurry, 75 Manuals, 8
capturing and saving in projector, 54 to 55 Menus
correcting shape, 21 to 22, 50, 74 changing settings, 44 to 45
fitting on screen, 49, 73 to 74 default settings, restoring, 45
height, adjusting, 20 Image, 46 to 47
problems with, 72 to 76 Info, 71
projecting on chalkboard, 30 Signal, 48 to 49
raising, 20 User’s Logo, 54 to 55
selecting source, 17, 27, 37 to 40 Mouse
size and projection distance, 14, 83 compatibility, 83
turning off (using A/V Mute), 23, 28 connecting cable for remote, 35
zooming, 21, 29 using remote control as, 31

Image menu, 46 to 47
Info menu, 71
Input signal, selecting, 17, 27, 37 to 40

Installing projector, 81 to 82 New Hardware Wizard, 17

No Signal message, 18, 72 to 73
Noise level, 83

Not Supported message, 73
Kensington anti-theft device, 11, 15 Numeric keypad, using, 52
Keystone correction, 21 to 22, 50, 74, 83
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Operation Lock setting, 56
Optical aspect ratio, 83
Options for projector, 11

Password

protection, 51 to 54

request code, 53
Photo color mode, 30, 46
Picture source, selecting, 17, 27, 37 to 40
Picture, see Image
Pointer tool, using, 32
Positioning

image, 20

projector, 14 to 15, 81 to 82
Power

button, 17

specifications, 84

status light, 17, 69 to 70
Presentation color mode, 30, 46
Presentations

computer, 23, 34 to 35

room conditions, 14, 26

tips and training, 9

using the pointer tool, 32

video, 36 to 40
Presenters Online, 9
PrivateLine Support, 8
Problems

color, 76

image, 72 to 76

no signal, 18, 72 to 73

remote control, 77

sound, 76 to 77

using on-screen help, 68
Progressive format, 49
Projecting without screen, 30
Projection lamp, see Lamp

Projector
carrying case, 66
cleaning, 60
disabling buttons, 56
distance from screen, 14, 83
installing, 81 to 82
lamp specifications, 84
options, 11
password protection, 51 to 54
positioning, 14 to 15
resolution, 83
specifications, 83 to 85
transporting, 66
troubleshooting, 67 to 70
turning off, 23 to 24
turning on, 15 to 17
unpacking, 10
viewing information about, 71

Raising image, 20
Rear-screen projection, 57, 81 to 82
Registration, 9
Remote control
A/V Mute button, 28
as wireless mouse, 31
battery used, 84
connecting cable for mouse, 35
correcting color, 30
E-Zoom button, 29
Freeze button, 28
information, 91
numeric keypad, using, 52
pointer tool, using, 32
problems, 77, 91
range, 84
specifications, 84
switching sources, 27
troubleshooting, 77
Replacing lamp, 62 to 65
Request code, password, 53
Resetting lamp timer, 65
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Resetting menu options, 45
Resize image, 30
Resolution, 30, 73, 83

Safety

instructions, 89 to 90

specifications, 85
Saturation setting, 47
Screen

blank, 18 to 19

distance from projector, 14, 83

ordering, 11

startup screen, creating, 54 to 55
Screen image, See Image
Security

Kensington lock, 11

password protection, 51 to 54
Sharpness setting, 47
Signal menu, 48 to 49
Six-axis color adjustment, 47 to 48
Sleep mode, 24
Sound

troubleshooting, 76, 77
Source

selecting, 17, 27

viewing, 71
Speaker, specifications, 83
Specifications

brightness, 83

dimensions, 84

electrical, 84

environmental, 85

general, 83

lamp, 84

remote control, 84

resolution, 83

safety, 85
Sports color mode, 30, 46
sRGB color mode, 30, 46
Startup screen

user’s logo, See User’s Logo
Startup screen, creating, 54 to 56
Status lights, 69 to 70

100 /ndex

Support, see Technical support

S-video cable, 11, 38

Switching picture source, 17, 27

Sync setting, 49

Synchronization, adjusting, 23, 75 to 76

Technical support, 8, 78 to 79
Temperature
requirements, 85
status light, 69 to 70
Temperature, color, 47
Theatre color mode, 30, 46
Tint setting, 47
Tracking, adjusting, 23, 75 to 76
Transporting projector, 66
Troubleshooting
blank screen, 18 to 19, 72 to 73
cut-off image, 73 to 74
distorted image, 21 to 22
image and sound problems, 72 to 77
no signal, 18, 72 to 73
projector problems, 67 to 70
remote control problems, 77
Turning off picture (using A/V Mute), 28
Turning off projector, 23 to 24

Unpacking projector, 10
USB cable, 10, 35
User’s Logo menu, 54 to 55

VCR, connecting, 36 to 40
Video
cables, 10, 11, 36
connecting video equipment, 36 to 40
display settings, viewing, 71
formats, supported, 85 to 87
selecting source, 17, 27, 37, 38
Video Signal setting, 49
Volume, controlling, 29



Warning lights, 69 to 70
Warranty, 9, 94 to 95
Windows

display problems, 73

resolution setting, 74
Wireless

module, 10
Wireless, mouse, 31, 35

Zoom ratio, 83
Zooming image, 21, 29
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